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Necroptosis is a form of inflammatory lytic cell death involving active cytokine
production and plasma membrane rupture. Progression of necroptosis is tightly
regulated in time and space, and its signaling outcomes can shape the local
inflammatory environment of cells and tissues. Pharmacological induction of
necroptosis is well established, but the diffusive nature of chemical death in-
ducers makes it challenging to study cell-cell communication precisely during
necroptosis. Receptor-interacting protein kinase 3, or RIPK3, is a crucial sig-
naling component of necroptosis, acting as a crucial signaling node for both
canonical and non-canonical necroptosis. RIPK3 oligomerization is crucial to
the formation of the necrosome, which regulates plasma membrane rupture and
cytokine production. Commonly used necroptosis inducers can activate multi-
ple downstream signaling pathways, confounding the signaling outcomes of
RIPK3-mediated necroptosis. Opsin-free optogenetic techniques may provide
an alternative strategy to address this issue. Optogenetics uses light-sensitive
protein-protein interaction to modulate cell signaling. Compared to chemical-
based approaches, optogenetic strategies allow for spatiotemporal modulation
of signal transduction in live cells and animals. We developed an optogenetic
system that allows for ligand-free optical control of RIPK3 oligomerization and
necroptosis. This article describes the sample preparation, experimental setup,
and optimization required to achieve robust optogenetic induction of RIPK3-
mediated necroptosis in colorectal HT-29 cells. We expect that this optogenetic
system could provide valuable insights into the dynamic nature of lytic cell
death. © 2024 The Authors. Current Protocols published by Wiley Periodicals
LLC.
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INTRODUCTION

Cell death is an essential mechanism to maintain the homeostasis of multicellular or-
ganisms. Apoptosis is a form of programmed cell death that clears apoptotic corpses
in a “quiet” way, in that minimal inflammatory factors are released. Necrosis, which is
typically not programmed, proceeds with membrane rupture and release of cellular con-
tents into the extracellular space, resulting in inflammation. Necroptosis bears features
of both apoptosis and necrosis in that cell rupture proceeds with concomitant upregu-
lation of proinflammatory cytokine production. Defective necroptosis has been reported
in multiple inflammatory diseases, such as inflammatory bowel diseases (IBD) and neu-
rodegenerative diseases. Therefore, understanding the precise mechanism of necroptosis
should benefit the development of future therapeutics.

A well-established canonical necroptosis pathway is initiated by tumor necrosis factor
alpha (TNFa). TNFa binding to its receptor, TNF receptor 1 (TNFR1), recruits receptor-
interacting protein kinase 1 (RIPK1) and other proteins to form a receptor complex
called complex-I at the plasma membrane, which further promotes activation of the nu-
clear factor kappa B (NF-kB) pathway (Zhu et al., 2018). When apoptosis is blocked
by the broad-spectrum caspase inhibitor ZVAD-FMK, a membrane-less protein complex
called a necrosome is formed, containing RIPK1 and RIPK3 (Cho et al., 2009). RIPK3
phosphorylates mixed lineage kinase domain-like (MLKL) and causes membrane rup-
ture (Dondelinger et al., 2014; Sun et al., 2012). Non-canonical necroptosis also ex-
ists, for example, in the case of viral induction, and proceeds through RIPK3-dependent
signaling processes. Highly inflammatory, necroptosis is regulated tightly in time and
space.

The commonly used pharmacological approaches to stimulate necroptosis may face chal-
lenges in delineating the spatial and temporal regulation of necroptosis, in part due to the
diffusive nature of chemical death inducers. Additionally, the potential off-target effects
of small molecules make it difficult to define the function of specific signaling compo-
nents such as RIPK3. One alternative strategy to address this issue is optogenetic tech-
nology, which engineers cells to harbor light-sensitive signaling molecules. Exposure to
visible light induces conformational changes in the light-sensitive signaling molecules
and activates downstream signaling pathways. Because light can be controlled precisely
in time and space, signaling modulation can be achieved at the single-cell or even subcel-
lular level (Fischer et al., 2022; Liu et al., 2022; Mazraeh & Di Ventura, 2022; Oh et al.,
2021).

Here, we demonstrate the optical control of necroptosis in live cells. The system
uses cryptochrome protein, a photoactivable protein that can be oligomerized by blue
light, to induce RIPK3 activation in live cells. In this article, we introduce the pro-
cedure of preparing lentivirus encoding the optogenetic RIPK3 system (Basic Proto-
col 1 and Support Protocol), lentiviral transduction (Basic Protocol 2), optimization
of optogenetic stimulation conditions (Basic Protocol 3), long-term time-stamped live-
cell imaging and optogenetic induction (Basic Protocol 4), and data analysis (Basic
Protocol 5).
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STRATEGIC PLANNING

Successful achievement of optogenetic induction of necroptosis requires high-quality
lentivirus, optimized optogenetic stimulation conditions, and familiarity with data anal-
ysis algorithms. Several steps can be performed in parallel, for example, Basic Protocols
1 and 3.

CAUTION: All procedures regarding lentivirus production, human cell line cultur-
ing, chemical transfection, and lentivirus transduction should be done in a certified
biosafety level 2 (BSL2) biosafety cabinet. Please handle all materials with great care
throughout the procedures to minimize potential microbe contamination. The imaging
room for handling live human cell line imaging should meet the BSL2 requirement as
well.

NOTE: All solutions and equipment coming into contact with cells must be sterile, and
proper sterile technique should be used accordingly, including using a certified biosafety
class II cabinet (Thermo Fisher 1300 Series A2).

NOTE: All culture incubations are performed in a 37°C, 5% CO,, 95% air incubator
unless otherwise specified.

PRODUCTION OF LENTIVIRUS ENCODING THE OPTOGENETIC RIPK3
SYSTEM

This protocol outlines the steps to produce lentivirus encoding the optogenetic RIPK3
system. Lentivirus transduction is essential to achieve effective gene delivery into HT-29
cells (Basic Protocol 2).

Materials

Low-passage (<P15) HEK293T cells (ATCC, cat. no. CRL-3216)

Complete DMEM [supplemented with fetal bovine serum (FBS); see recipe], 37°C

Plasmids:

Transfer plasmid (for optogenetic RIPK3)
Packaging plasmid (psPAX2)
Envelope plasmid (pMD2.G)

TurboFect Transfection Reagent (Thermo Fisher, cat. no. R0532)

Dulbecco’s Modified Eagle’s Medium (DMEM; Corning, cat. no. 10-013-CV) with
antibiotics (1x penicillin/streptomycin, from 10,000 U/ml stock; Corning, cat.
no. 30-002-CI) and without FBS

Lenti-X Concentrator (Takara, cat. no. 631231, lot no. 1710388A)

Complete medium of user’s choice or Dulbecco’s phosphate-buffered saline
(DPBS; Thermo Fisher, cat. no. 14040141)

100-mm culture plates (Fisherbrand, cat. no. FB012924)

1.5-ml Eppendorf tubes (Thermo Fisher)

15- or 50-ml Falcon tubes (Thermo Fisher)

Standard tabletop centrifuge (Sorvall ST 8 Centrifuge, Thermo Fisher, cat. no.
75007200), room temperature and 4°C

0.4-pm syringe filters, sterile (Milltex PVDF 0.45 pm Sterile Syringe Filter,
Millipore/Sigma-Aldrich, cat. no. SLHVR33RS)
10-ml syringes, sterile (Fisherbrand, cat. no. 14-955-459)

Additional reagents and equipment for measuring lentivirus concentration (see
Support Protocol)
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A HEK293T B HEK293T
Non-transfected Transfected for lentivirus production

Figure 1 HEK293T cells show unhealthy morphology during lentivirus production. (A) Non-
transfected HEK293T cells show stretched cell morphology. (B) When transfected with the trans-
fer plasmid, psPAX2, and pMD2.G, cells show aggregation and shrinkage, a good sign for potent
lentivirus production. Scale bars, 50 pm.

1. Grow low-passage HEK293T cells in a 100-mm culture plate in 10 ml complete
DMEM (supplemented with FBS) at a 10% initial seeding density until 85% to 90%
confluent to maximize the virus yield.

Using a 10-ml serological pipet (Thermo Fisher, cat. no. 170356N) and controller
(Thermo Fisher S1 Pipet Filler, Thermo Fisher, cat. no. 9501) will make all steps of the
protocol much easier to complete.

2. Prepare 800 pl transfection mix in a 1.5-ml Eppendorf tube, with a 3:2:1 molar ratio
of transfer/packaging/envelope plasmid and a ratio of DNA/TurboFect Transfection
Reagent of 1 pgto 3 pl

The weight ratio of transfer (bp)/packaging (bp)/envelope (bp) = 9628:10699:5800 =
1:1.11:0.6. This is the weight ratio to ensure a 1:1:1 molar ratio. Thus, for a molar ratio
of 3:2:1, the weight ratio should be 3:2.22:0.6. Distribute 8000 ng total weight using this
ratio and measure the weight of each plasmid as 4123 ng (transfer), 3052 ng (packaging),
and 825 ng (envelope).

3. Once the transfection mix is made, gently remove the old culture medium and re-
plenish with 7.2 ml DMEM with antibiotics and without FBS (8 ml total volume).

4. Wait for 20 min for the lipid particle to generate complex at room temperature.
5. Add 800 1 of the transfection mix evenly to the plate dropwise.
Gently add the medium to the side wall of the plate so as not to unexpectedly detach cells.
6. Incubate the transfected cells in a 37°C, 5% CO, incubator for 20 hr.
7. After 20 hr, replace the medium with 8 ml complete DMEM.
Gently add the medium to the side wall of the wells so as not to detach cells.

Successfully transfected cells should show slight shrinkage and clustering, a good sign
for effective lentivirus production (Fig. 1).

8. Incubate the plate again at 37°C and 5% CO; for an additional 48 hr.

9. To harvest viral particles, proceed by gently pipetting virus-containing medium into
a 15- or 50-ml Falcon tube.
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The volume of medium will change depending on how many plates the user is harvesting;
the harvest can be scaled by multiplying the transfection mix volume by the number of
plates used.

10. Centrifuge virus-containing medium for 7 min at 500 x g to acquire pellet.
There should be a visible white pellet toward the bottom of the tube.

11. Gently draw the supernatant into a pipet without disturbing the cell pellet and filter
through a 0.45-pm syringe filter using a 10-ml syringe into another 15- or 50-ml
Falcon tube. Discard the pellet.

12. Measure virus concentration using Lenti-X GoStix Plus lentiviral titer kit (see Sup-
port Protocol).

The next step is to concentrate and then store the virus at —80°C (see steps 13 to 20;
recommended).

13. Mix the filtered supernatant with Lenti-X concentrator at a 3:1 ratio of filtered virus
medium/concentrator.

14. Incubate the sample on ice for >1 hr.

15. Centrifuge concentrated medium for 45 min at 1500 x g, 4°C.
A viral pellet should be visible after centrifugation.

16. Remove supernatant without disturbing the pellet.

17. Add complete medium of the user’s choice or DPBS to the pellet at 1/10 or 1/100
of the original supernatant volume.

The complete medium should be that of the target cells to be transduced later by the user.
The dilution varies depending on the user’s needs.

18. Gently resuspend the viral pellet by pipetting up and down 50 times without forming
bubbles.

19. Once the viral pellet is resuspended, measure the concentration of the virus using
the Lenti-X GoStix Plus lentiviral titer kit (see Support Protocol).

The concentrated virus should be diluted 10- to 100-fold before loading into the titer kit
to avoid saturation.

20. Store product for 2 to 4 months at —80°C. Thaw when needed.

Please see information about sample data in the Understanding Results section.

QUANTIFICATION OF THE TITER OF LENTIVIRUS

This support protocol lists steps to quantify the titer of lentivirus from Basic Protocol 1.
Follow the guide on Takara’s website for the Lenti-X GoStix Plus lentiviral titer kit.

Materials

Lenti-X GoStix Plus lentiviral titer kit (Takara, cat. no. 631280), containing
cassette and chase buffer
Diluted virus sample (from concentrated virus from Basic Protocol 1)

Smartphone

1. Download the GoStix Plus app (available on Google Play or in the Apple App Store
by searching “GoStix Plus” in the search bar) onto a smartphone.
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10.

11.

Optional: Add an email address to have the result sent to that address.

Enter the lot number by scanning the QR code on the Lenti-X GoStix Plus lentiviral
titer kit foil pouch. Press the QR code icon to activate the scanner.

The user can also enter the lot number manually.
Enter the number of tests to be scanned (1 to 8 tests).
Enter the sample names and the appropriate dilutions and then click “start.”

Following the prompts within the app, add 20 1 diluted virus sample to the cassette
from the kit.

Dilution may be needed. See the Troubleshooting section for more information.

Add 80 w1 chase buffer to the sample well and wait for 10 min using the timer in the
app.

Ensure that the control band appears on the left and the test band appears on the
right.

Using the app, align the cassette using the alignment tool.

Proper alignment and focal length for imaging are achieved by using the outline of the
cassette in the scanning window.

Once proper alignment is achieved, the outline will turn green, and the cassette will
automatically be scanned to measure the intensity of each band.

Once all samples are scanned, view the results in the “Result detail” window. Press
“done” if all samples have been scanned.

Interpret the results.

A discussion of the interpretation of results can be found on Takara’s website
(https://www.takarabio.com/learning- centers/ gene-function/viral-transduction/
lentivirus/lenti-x- gostix-plus-faqs). The GoStix Value (GV) units given to the user quan-
tify the concentration of p24 protein in nanograms. Please visit takarabio.com/gostixhelp
for additional guidance on retrieving downloaded results.

Please see information about sample data in the Understanding Results section.

CULTURING, CHEMICAL TRANSFECTION, AND LENTIVIRUS
TRANSDUCTION OF HT-29 CELLS

This protocol outlines the steps to culture the colorectal HT-29 cell line and perform
chemical transfection or lentivirus transduction. A sufficient gene delivery rate can be
achieved in HEK293T cells by either chemical transfection or lentiviral transduction.
However, HT-29 cells require lentiviral transduction for effective gene delivery (Fig. 2).

Materials

HT-29 cells (ATCC, cat. no. HTB-38)

Complete HT-29 cell culture medium (see recipe), 37°C

Optogenetic RIPK3 (fused with mCherry) plasmid

Opti-MEM medium (Thermo Fisher, cat. no. 31985062)

PEI MAX (Polysciences, cat. no. 24765-1)

Concentrated and quantified La-RIPK3 virus (see Basic Protocol 1 and Support
Protocol)

Polybrene transfection reagent

70% (v/v) isopropyl alcohol
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A HEK293T B HEK293T c HT-29 D HT-29
No transduction Lentiviral transduction Chemical transfection Lentiviral transduction
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Figure 2 Lentiviral transduction provides a more effective gene delivery rate than chemical trans-
fection. (A) HEK293T cells were treated with complete medium supplemented with polybrene (8
wg/ml). (B) HEK293T cells were treated with complete medium supplemented with polybrene (8
ng/ml) and the optogenetic RIPK3 lentivirus after the original virus-containing medium was con-
centrated 10 times. (C) HT-29 cells were transiently transfected with non-viral optogenetic RIPK3
plasmid, and images were taken 24 hr post-transfection. (D) HT-29 cells were transduced with
lentivirus supplemented with polybrene (8 jwg/ml), and images were taken 96 hr post-treatment.
Scale bars, 50 um.

60-mm culture plates (Fisher Scientific, cat. no. FB012921)

24-well culture plates (Fisherbrand, cat. no. FB012929)

Standard tabletop centrifuge (Sorvall Legend XTR) with swinging-bucket rotor
(Thermo Scientific, TX-1000) and plate adapter

Parafilm

Large Kimwipes

Cell culture
1. Culture HT-29 cells in 4 ml complete HT-29 cell culture medium in a 60-mm culture
plate at an initial seeding density of 2 x 10° cells, changing the medium every 3 days
and splitting the cells when they are 80% confluent.

Chemical transfection
2a. Plate 1.6 x 10° cells/ml in a 24-well culture plate for chemical transfection.

Use a 300-ul seeding volume per well to have a more even distribution of cells within
each well of the 24-well plate.

3a. Incubate the cells for 2 days. Supplement them with 500 pl fresh complete HT-29
cell culture medium 24 hr after cell plating.

4a. Gently remove the medium and add 450 pl fresh complete HT-29 cell culture
medium before transfection.

Sa. Prepare transfection mix using 500 ng of the optogenetic RIPK3 (fused with
mCherry) plasmid 1.5 ul PEI MAX, and Opti-MEM medium to 50 pl.

6a. Incubate the transfection mix for 15 min at room temperature.
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Figure 3 Setup for spinning down tissue culture plates. The tissue culture plate is wrapped before
spinning to keep humidity and CO, in the wells.

7a. Add 50 pl transfection mix to each well dropwise and incubate the cells for 4 hr.
Gently rock the plate to facilitate the diffusion of the mix to the cells.

8a. After 4 hr, remove the transfection medium and add 500 pl fresh complete HT-29
cell culture medium to the cells.

Chemically transfected cells should show fluorescence from mCherry (Fig. 2C).

Lentivirus transduction
2b. Plate 1.6 x 107 cells/ml in a 24-well culture plate for lentivirus transduction.

3b. Pre-warm the centrifuge with a swinging-bucket rotor to 30°C.

To preset the pre-warming temperature, hold the “temp” button on the Sorvall Legend
XTR for a few seconds and then set the temperature to 30°C. Click “start,” and the cen-
trifuge will start to rotate to warm it up. It will take about 30 to 60 min to pre-warm the
centrifuge to 30°C. Once the warming is done, the instrument makes a beeping sound.

4b. Make a virus cocktail to be added to the target cells.
i. Concentrated and quantified La-RIPK3 virus amount: 1501 GV.
GV units are custom units from Takara and are ng/ml of the p24 protein of the lentivirus
capsid.

This procedure is for 24-well plates. Ideally, the amount of virus should be increased or
decreased based on the area of the plate.

ii. Polybrene transfection reagent: final concentration 8 pg/ml.
iii. Make up the rest of the volume with the complete medium of the target cells.

5b. Add the virus cocktail to the HT-29 cells in the 24-well plate (see step 2b).
6b. Incubate the cells in the 37°C incubator for 10 min.

7b. Proceed to spin infection:
i. Sterilize the centrifuge plate adapter with 70% isopropyl alcohol.
ii. Parafilm the entire junction of the cell plate and its lid and then wrap it with a
large Kimwipe (Fig. 3).
This is done so the CO, and humidity can be maintained better during the I-hr centrifu-
gation (see step 7b, iii). Wrapping the plate using a Kimwipe minimizes the chance of
contamination by bacteria likely to be present in the centrifuge.
iii. Place the Kimwipe-wrapped plate into the centrifuge adapter and balance the
other side of the rotor with a plate of similar weight (within 1 g of difference).
iv. Proceed to centrifugation for 1 hr at 3000 rpm in a TX-1000 swinging-bucket
rotor, 30°C.

Spin infection can improve the viral transduction of certain cells (this is mandatory for
HT-29 cells).

8b. Once centrifugation is done, remove the Parafilm and return the plate to the
incubator.
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9b. Replace medium with 500 pl fresh complete medium 24 hr post-transduction.

Expression of optogenetic RIPK3 can be examined by measuring the fluorescence of
mCherry.

Note that different cell lines show significant variation in the transduction rate. For ex-
ample, HEK293T cells (Fig. 2D) show a higher transduction rate compared with HT-29
cells (Fig. 2B).

Please see information about sample data in the Understanding Results section.

OPTIMIZATION OF OPTOGENETIC STIMULATION CONDITIONS

This protocol lists steps to optimize the optogenetic stimulation conditions for minimal
phototoxicity.

Materials

Stable HT-29 cells expressing the optogenetic RIPK3 system (see Basic Protocol 2)
SYTOX Green (Thermo Fisher, cat. no. S7020; see Basic Protocol 4, step 3)

Environmental control enclosure system (In Vivo Scientific)
Inverted microscope (Leica DMIS)
Imaging software (Leica LAS-X, Micromanager 1.4)

1. Treat the stable HT-29 cells expressing the optogenetic RIPK3 system with 100 ul
SYTOX Green per well for 10 min in a sterile biosafety cabinet.

The final concentration of SYTOX Green (which stains Iytic cells) should be 0.5 uM in each
well.

2. Turn on the environmental control enclosure system (5% CO, and 37°C; Fig. 4A)
1 hr before imaging. Adjust the flow rate to 300 cm>/min (ccm).

This helps to avoid water condensation during imaging.

3. Turn on the inverted microscope shortly before imaging (see Fig. 4 for setup of hard-
ware and software).

4. Set the fluorescence intensity manager (Fig. 4B) at the second position.

5. Usea 10x objective and set the plate of stable HT-29 cells expressing the optogenetic
RIPK3 system under the microscope.

6. Set up imaging parameters in imaging software as follows:
a. Texas red (TXR): 100 ms.

Purpose: To identify cells expressing the optogenetic RIPK3 system with mCherry.
b. GFP: 15 ms.

Purpose: To capture SytoxGreen-stained lytic cells and provide optogenetic stimulation.
c. GFP: 80 ms.

Purpose: To provide an extra dose of light for optogenetic stimulation. Two-step GFP stim-
ulation is used so that signals for SytoxGreen-stained cells will be saturated and sufficient
blue light is supplied for optogenetic stimulation.

d. Brightfield: 100 ms.

Purpose: To capture cell morphology.
e. Dark interval: 5 min.

Purpose: To minimize phototoxicity.

f. Total imaging acquisition time: 20 hr.
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Figure 4 Hardware and software for acquiring images of optogenetic induction of RIPKS3-
mediated necroptosis. (A) Side view of the microscope equipped with an environmental control
chamber that tunes the temperature and CO, concentration for long-term live-cell imaging. A1,
Sample holder and a plate with cultured cells. (B) Rear view of the microscope, highlighting the
tubes and CO, regulator. B1, Fluorescence intensity manager (FIM) and the liquid guide for light
delivery. (C) Software interface for data acquisition.

7. Examine cell membrane rupture.

Less than 5% cell membrane rupture should occur in wild-type cells. If a more vulnerable
cell type is used, reduce the power and exposure time of the excitation light.

TIME-STAMPED LIVE-CELL IMAGING OF HT-29 LYTIC CELL DEATH
This protocol outlines the steps to achieve time-stamped live-cell imaging that captures
HT-29 lytic cell death.

Materials

Stable HT-29 cells expressing the optogenetic RIPK3 system (see Basic Protocol 2)
Wild-type HT-29 cells (ATCC, cat. no. HTB-38)

Complete HT-29 cell culture medium (see recipe), 37°C

SYTOX Green (Thermo Fisher, cat. no. S7020)
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12-well culture plates (Fisherbrand)

Inverted microscope (Leica DMIS) with optimized optogenetic stimulation
conditions (see Basic Protocol 3)

Imaging software (Leica LAS-X, Micromanager 1.4.)

Image] software

1. Plate two wells of stable HT-29 cells expressing the optogenetic RIPK3 system and
two wells of wild-type HT-29 cells (Gene-/Dark, Gene-/Light, Gene+/Dark, and
Gene+/Light) in complete HT-29 cell culture medium in a 12-well culture plate at a
seeding density of 0.25 x 10° cells per well and incubate for 24 hr in a 37°C and 5%
CO; incubator.

2. Remove old medium from each well and wash away dead cells three times using fresh
medium. Then, add 900 ul fresh medium to the cells and incubate for 30 min at 37°C
and 5% CO,.

Before aspirating old medium from each well, tilt the 12-well plate at a 45° angle and move
it in a circular motion to bring down any dead cells. Draw out the medium while holding
the plate tilted, using a vacuum aspirator to ensure the dead cells are removed. Repeat the
wash three times using fresh medium to completely remove any dead cells.

3. Stain the cells with 100 ul SYTOX Green per well for 10 min at room temperature in
a sterile biosafety cabinet.

The final concentration of SYTOX Green (which stains Iytic cells) should be 0.5 uM in each
well.

4. Start the imaging software and create a new project to be saved as an LIF file.

5. Proceed with live-cell imaging under the inverted microscope with optimized optoge-
netic stimulation conditions (see Basic Protocol 3), including the following imaging
parameters:

TXR: 100 ms.

GFP: 15 ms.

GFP: 80 ms.

. Brightfield: 100 ms.

. Dark interval: 5 min.

. Fluorescence intensity attenuator: position 2.
. Total data acquisition time: 20 hr.

@m0 R0 TR

6. Remove the plate after 20 hr of imaging, save the project LIF file (or TIFF stack of
images), and analyze data using ImagelJ software.

QUANTIFICATION OF HT-29 LYTIC CELL DEATH
This protocol outlines the data analysis steps to quantify HT-29 lytic cell death.

Materials

FUI (https://imagej.net/ software/fiji/)

CellProfiler (https://cellprofiler.org)

Desktop computer (computer with >16 GB RAM and fast CPU; preferred, Intel i7
or AMD Ryzen 7 equivalent)

TIFF stack acquired from microscope software (see Basic Protocol 4)

Microsoft Excel or equivalent quantification software (Matlab, Origin)

1. Open up FIJT and CellProfiler on a desktop computer.

2. Using FIJI, open up the TIFF stack acquired from microscope software by selecting
File > Open > Browse.
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Figure 5 Time-stamped images of optogenetic induction of RIPK3-mediated lytic cell death. (A)
HT-29 cells were transduced with lentivirus encoding the optogenetic RIPK3 system and cultured
in an environmental control chamber. Blue light stimulation causes RIPK3-containing necrosome
formation and membrane rupture. SYTOX Green stain was used to stain lytic cells. A pulse of 95-ms
blue light stimulation was applied every 5 min, and cell morphology and staining were monitored.
Representative images of a cluster of cells undergoing necroptosis are shown. Cell death proceeds
through a burst and flattening of cell membranes concurrently stained by SYTOX Green. (B) Time-
dependent cell death in dark and light conditions.

3. If the option is available, check the box “Open Virtual Stack” to reduce the amount
of RAM used. Proceed by clicking “Okay”.

4. Select Image > Color > Split Channels to split the individual color channels into
Bright Field (Grey), SytoxGreen (Green), and mCherry-labeled Lentivirus (Texas
Red).

5. Save each color channel separately in Image Sequence format by clicking File >
Save as > Image Sequence (for easy documentation, these should be saved to a
separate folder). Save representative cell death images by cropping the stack images
(Fig. 5A).

6. For all constructs needing to be analyzed, open and organize all files in the same
manner as in steps 2 to 5 for easy identification in CellProfiler.

Channels can be merged back by selecting Image > Color > Merge Channels and then
clicking the corresponding color needed to merge for each color. For example, if the user
wants to overlay a brightfield image with SytoxGreen only, they will select the brightfield
TIFF stack as the “Grey” channel and the SytoxGreen TIFF stack as “Green”. Then,
the movie can be saved in the format the user desires through the same navigation as in
step 5.
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The GFP image with 15-ms exposure time is preferred for image analysis to avoid signal
saturation. If the fluorescence signal is too weak, consider using the image with 80-ms
exposure time.

7. Using CellProfiler, open an Image Sequence file previously created in step 5 by
dragging the folder into CellProfiler.

8. In the Adjust Modules panel, click the “+” icon and search for IdentifyPrimaryOb-
jects. Double-click to add a module.

9. In the same panel, search for ExportToSpreadsheet. Double-click to add a module.
10. In IdentifyPrimaryObjects, adjust the following parameters:

a. Use Advanced Settings by clicking “Yes”.
b. Select the input image stack previously created in step 7.
c. Adjust the typical diameter size of the cells to be analyzed.

For HT29 cells, this value could range between 10 (min) to 20 (max) pm.

d. Use the “Otsu” thresholding method.
e. Adjust thresholding correction value to between 0.5 and 1.

See Troubleshooting for why this is an important value.

f. Allow all other settings to be the default.

11. In ExportToSpreadsheet, use the following settings:

a. Direct the output file to the desired folder.
b. Double-check that “Comma” is selected for column delimiter.
c. Allow all other settings to be the default unless changes are desired.

12. Once all settings are completed, click “Analyze Images” to start the analysis.

The progress bar on the bottom will show how many images CellProfiler has left to ana-
lyze before saving all data to the exported spreadsheet.

13. Repeat steps 7 to 12 for all other sets of images in three biological replicates.

14. Openthe CSV file generated by CellProfiler into Microsoft Excel or equivalent quan-
tification software to further analyze the data into a time series or to perform other
quantification methods.

For example, if the user wants to quantify the percentage of cell death, the following
equation can be used in Excel:

_ #of SytoxGreen cells

x 100%
# of mCherry Cells

15. Plot the time-dependent cell death from the compiled results (Fig. 5B).

Please see information about sample data in the Understanding Results section.

REAGENTS AND SOLUTIONS
Complete DMEM

DMEM (Corning, cat. no. 10-013-CV)

10% (v/v) FBS (Sigma-Aldrich)

1x penicillin/streptomycin (10,000 U/ml stock; Corning, cat. no. 30-002-CI)
Store <1 week at 4°C

Complete HT-29 cell culture medium

McCoy’s SA medium (ATCC, cat. no. 30-2007)
10% (v/v) FBS (Sigma-Aldrich)
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1x penicillin/streptomycin (10,000 U/ml stock; Corning, cat. no. 30-002-CI)

Store <1 week at 4°C

COMMENTARY

Background Information

Well-established genetic and cell biologi-
cal strategies have played a pivotal role in the
study of cell death pathways. These previous
studies provide the foundation for the design
of optogenetic systems. Optogenetic stimula-
tion provides high resolution in spatial and
temporal control of cell signaling and there-
fore could provide new insights into the dy-
namic nature of cell death pathways. However,
careful design of optogenetic experiments is
warranted to verify the effect of the optoge-
netic response.

Critical Parameters

Gene delivery methods: Chemical versus
lentivirus

Two commonly used gene delivery meth-
ods are chemical transfection and lentiviral
transduction (see Basic Protocol 2). Chemi-
cal transfection uses cationic molecules that
can partially neutralize the negative charge
of DNA plasmids, which facilitates trans-
port through the plasma membrane. Lentivirus
packages the encoding genes in the transfer
plasmid and forms non-propagated viral parti-
cles that infect the target cells. Chemical trans-
fection can be done within 2 to 4 hr. Gene
expression starts at ~6 hr post-transfection.
Lentivirus requires initial transfection in host
cells (typically HEK293T cells), collection of
the conditioned medium in 48 to 72 hr, and pu-
rification and concentration if needed. Upon
transduction, gene expression takes another
3 days to 1 week.

The choice of gene delivery method de-
pends on the cell model and the purpose of the
application. Chemical transfection, despite
its convenience and fast timeline, cannot
provide sufficient transfection efficiency for
all cell lines. In extremely challenging cell
lines like HT-29 cells or primary culture,
the transfection efficiency could be as low
as 1%. Additionally, the gene expression
profile is extremely heterogeneous. Lentivi-
ral transduction provides a titer-dependent
transduction rate. In our experience, the HT-
29 transduction rate can reach 40% to 50%
with lentiviral transduction. The expression
profile from lentiviral transduction is more
homogeneous. Whereas chemical transfection
might be sufficient if the purpose is to observe
single-cell behavior (e.g., through imaging),

biochemical and cell biological analysis of
cells (e.g., phosphorylation of target proteins
or metabolic responses) may benefit from
transduction from lentivirus or other viral
vectors.

Choice of optogenetic systems and
optimization of stimulation conditions

When working with a new cell or tissue
model, optogenetic stimulations should be op-
timized to minimize phototoxicity (Basic Pro-
tocol 3). Commonly used optogenetic sys-
tems use visible light as a stimulating source.
Light with shorter wavelengths introduces
greater phototoxicity than that with longer
wavelengths. Additionally, longer-wavelength
light has a slightly deeper penetration depth
than shorter-wavelength light and therefore is
preferred for in vivo studies. However, dif-
ferent optogenetic systems also show differ-
ent light sensitivity, e.g., different light-to-
dark dynamic ranges or Kd ranges. Thus,
the efficacy needs to be individually tested.
Once a working system is confirmed, op-
tical stimulation conditions should be opti-
mized. Continuous exposure will introduce
greater phototoxicity. Thus, an intermittent
stimulation pattern could be used. The bot-
tom line is to identify a safe range of exper-
imental parameters, including wavelength, in-
stantaneous light power, and total dosage, that
do not introduce phototoxicity to wild-type
cells.

Necessary controls
Whenever possible, optogenetic experi-

ments (Basic Protocol 4) should be car-
ried out with quadrant conditions in mind.
Three controls are needed to delineate the
optogenetic response, including Gene-/Dark,
Gene-/Light, and Gene4/Dark. Only when
all three controls show distinct cell responses
from Gene+/Light could one safely inter-
pret the observed phenotype as an opto-
genetic response. Figure 6 shows the dis-
tinct plasma membrane rupture phenotype
in wild-type (non-transfection), mCherry-
CRY2clust-transfected (without RIPK3), and
optogenetic RIPK3—transfected cells after
blue light stimulation. As expected, wild-type
and mCherry-CRY2clust-transfected HT29
cells were not stained by SYTOX Green, indi-
cating intact membranes, whereas optogenetic
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Figure 6 Representative images of HT-29 cells 20 hr after blue light stimulation under each
condition. Optogenetic RIPK3—transfected cells (top) undergo blue light—inducible lytic cell death,
which is confirmed by SYTOX Green staining. mCherry-CRY 2clust-transfected (no RIPK3, middle)
and wild-type (no transfection, bottom) cells are not stained, indicating intact membranes.

Table 1 Troubleshooting Guide for All Basic Protocols

Problem

Possible cause

Solution

Cells are over-confluent in the
culture plate after adding the
transfection mix

Poor transfection efficiency

Loss of viral product after
concentrating

No pellet seen after
concentrating

No cells were identified in
CellProfiler; fewer green objects
were identified, and more
yellow/magenta objects were
identified

DMEM with FBS was used

There are many possible reasons for this:
low-confluent cells; unhealthy cells; wrong
amounts of transfer, packaging, and envelope
plasmids; poor centrifugation; and/or
inadequate cell conditions

Incubation without ice or not incubated long
enough

Inadequate incubation time after mixing the
virus with concentrator

The thresholding correction factor will help
CellProfiler differentiate a cell from the
background. If the thresholding factor is too
low, CellProfiler cannot differentiate. However,
the thresholding factor cannot be too high
because CellProfiler will misidentify objects in
the frame that are not cells.

Remember to use DMEM
without FBS for a reduction in
cell growth during the
transfection period.

Follow the proper molar ratio of
plasmids and adhere to
incubation times. Take pictures
of any viral pellet found after
concentrating for further
verification that the transfection
was successful.

Incubate for >1 hr. Use ice
during incubation.

Incubate the virus and
concentrator for a longer time.

Adjust the thresholding
correction factor according to
each image stack. This will
require some trial and error.

RIPK3—transfected cells were clearly stained
by SYTOX Green.

Real-time monitoring of cell response and
healthiness

For long-term illumination, one needs an
environmental chamber (Basic Protocols 3
and 4) that provides a sustained temperature
(37°C) and acidity (5% CO,) to ensure the
healthiness of cells. Light sources from the op-

Current Protocols

tical microscope can be directly used to stim-
ulate the optogenetic systems. Different chan-
nels of emission can be programmed together
to monitor the cellular response to optogenetic
stimulation in real time.

Troubleshooting

Common problems with the protocols, their
causes, and potential solutions are shown in
Table 1.
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Understanding Results

Interpretation of optogenetic induction of
Iytic cell death requires data analysis of multi-
color fluorescence images (Basic Protocol 5).
Using CellProfiler, the number of dead cells
versus time is shown (Fig. 5B). With opto-
genetic blue light simulation, the amount of
cell deaths increases over time. When com-
pared to control experiments undergoing no
stimulation, the number of dead cells re-
mains constant. One can compare the amount
of SytoxGreen versus mCherry signal to ac-
count for the percentage of cell death by
necroptosis.

Lentiviral transduction (Basic Protocol 2)
is crucial for effective gene delivery. When
producing lentivirus (Basic Protocol 1), a good
benchmark for sufficient yield is the morphol-
ogy of host cells (HEK293T) after transfection
with the mix of transfer, packaging, and en-
velope plasmids. Clustering and shrinkage of
cells are signs of effective transfection and
production of lentivirus particles (Fig. 1).
Because different cell lines show significant
variation in the transduction rate, lentivirus
transduction becomes mandatory for cell lines
like HT-29 cells (Fig. 2). Fluorescence imag-
ing provides a quick benchmark for transgene
expression. Biochemical analysis, such as
western blot or immunofluorescence staining,
can be used to validate the expression level.
Practically, we found that spinning down
the cells together with lentivirus increased
the transduction rate, but this procedure
needs to be optimized for different cell
lines.

Long-term imaging (Basic Protocol 4)
tracks the cell response in real time and is
selected as the primary way to quantify cell
death in this article. A full environmental con-
trol enclosure system (Basic Protocols 3 and
4) is used to maintain the temperature, hu-
midity, and CO, levels during data acquisition
(Fig. 4A). Regular maintenance and checkups
are warranted to ensure the appropriate func-
tioning of the unit (e.g., the gas tank, CO, reg-
ulator, water batch, and temperature measure-
ment). For data analysis (Basic Protocol 5),
automated algorithms minimize human bias
and are used in practice. Cells from different
fluorescence channels are selected, and their
intensity changes are recorded to calibrate
cell death (Fig. 5). Cells under control con-
ditions (e.g., wild-type, mCherry-CRY2clust)
show a distinct cell death phenotype com-
pared to optogenetic RIPK3-transfected cells
(Fig. 6).

Time Considerations

Basic Protocol 1: Production of lentivirus
encoding the optogenetic RIPK3 system:
3 days.

Basic Protocol 2: Culturing, chemical
transfection, and lentivirus transduction of
HT-29 cells: 3 days.

Basic Protocol 3: Optimization of optoge-
netic stimulation conditions: 24 hr.

Basic Protocol 4: Time-stamped live-cell
imaging of HT-29 lytic cell death: 24 hr.

Basic Protocol 5: Quantification of HT-29
lytic cell death: 2 hr.
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